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Introduction 

1. Motivation 
FN 

 State-of-the-art is  a simple circular radius fillet to avoid stress 
concentration (typically a quarter circle) 

 Classification in literature available for different size relations e.g. 
at shaft shoulders (diagrams, tables for Kt) [Decker 1985] 

 Common design procedure: Determine geometry (e.g. shaft 
shoulder measures & radius) and load state, then read out stress 
concentration factor (Kt, in German αk) from a diagram (see below) 

 Advantage: Simple to apply, no tests or FE analysis necessary 

 However, the state-of-the-art shows two significant limitations: 

1. The efficiency of stress 
reduction is very limited  
with a circular notch 
 

2. More efficient non-circular 
shapes usually have to be 
individually analyzed by 
numerical methods (FEM) 
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Introduction 

2. Intention 

 

FN 

 Goal is to provide well characterized non-circular notch 
shapes for standard load cases and cross section transitions, 
which 

1. are very efficient for stress reduction; 

2. are easy to analyze without use of a FE analysis, only by use of 
special normalized diagrams as for the circular notch and 

3. can be easily created by the use of standard features of modern 
CAD tools 

 To reach this goal efficiently: 

 A CAE tool is required that allows to create full-parametric 
geometry models  

 Subsequent FEM sensitivity and optimization analyses of these 
shapes based on the parametric model must be supported 

 Therefore, Creo Parametric and Creo Simulate  
in embedded mode were chosen (PTC Inc.) 



Part A: Used Software Functionality 
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Part A: Used Software Functionality  

1. Parametric Modelling 
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Semi-minor-axis 

 In a parametric CAD model, 
all objects/features like 
points, lines, curves, 
planes, etc. are described 
associatively as parameters 

 The parameter values can 
be changed easily; the 
model just has to be newly 
regenerated 

 Important for this is the 
clean, logical construction 
of the CAD model 

 The ideal base of a 
successful notch sensitivity 
and optimization analysis 
is a good parameterization 
of the CAD notch model, 
since many different 
sizes/relations shall be 
automatically examined! 

Very simple example: 

Elliptical notch 
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Part A: Used Software Functionality  

2. Software tools for analyzing parametric geometry 
2.1 Introduction 

 Creo Simulate offers different study types that allow to examine the 
influence of different parameters to certain physical quantities (stress, 
strain, stiffness, mass,…) and optimize the structure for certain goals 

 These parameters can be feature 
dimensions (e.g. wall thickness, 
radii), like used for this project, 
or certain physical properties  
(E-modulus, spring stiffness,…) 

 Since the CAD model is set up  
fully parametric, a wide range of 
parameter values (measures of the  
notches) can be studied and the  
results can be very efficiently  
displayed in sensitivity diagrams 

 Note: Simulate just owns a  
parameter optimizer, no shape 
optimizer! Smart model (dimension)  
parameters therefore have to be  
created! 
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 In a GSS, design variables (in our case 
feature dimensions) and their start- and 
end values (domain) have to be defined 

 The CAD model is then automatically 
regenerated for a number of equally 
spaced intervals (design domain), 
meshed and analyzed 

 Measure results (like max. von Mises 
stress) vs. design variable can then be 
displayed in sensitivity graphs  

Hint: Just change one parameter per  
analysis to better 
understand its 
influence! 

Part A: Used Software Functionality  

2. Software tools for analyzing parametric geometry 
2.2 Global Sensitivity Study (GSS) 
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Part A: Used Software Functionality  

2. Software tools for analyzing parametric geometry 
2.3 Local Sensitivity Study (LSS) 

 The LSS was not used directly in the 
project; it is described here just for 
completeness 

 This study allows to determine the variable 
affecting the results the most – but just for 
one “operating point” per analysis! 

 It is thought to preliminary examine the 
model to exclude design variables from an 
optimization study that have no or just a 
small influence only 

 Creo Simulate varies (±1%) the setting value 
individually for each variable and then just 
computes the slope for it at the actual 
operating point 

Hint: Unlike in the GSS, in the LSS you may 
therefore vary all design variables 
simultaneously! 
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Part A: Used Software Functionality  

2. Software tools for analyzing parametric geometry 
2.4 Optimization Study (OS) 

 In this study, the defined design variables are 
driven within their allowed domain to reach a 
certain goal while still defined design limits 
have to be satisfied (e.g. stress < 100 MPa) 

 An optimization study without a goal (e.g. 
“minimize total mass”) is a feasibility study! 

 Two algorithms are available: 
SQP – Sequential Quadratic Programming 
GDP – Gradient Projection 

 External optimizers may be embedded 

 This study allows to search for the next local 
minimum or maximum, which is not 
necessarily the global one: The starting point 
may be important therefore! 

Hint: Application experience shows that with 
more than two design variables, this study often 
does not work very efficient! 
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Part A: Used Software Functionality  

2. Software tools for analyzing parametric geometry 
2.5 Multi Objective Design Study (MODS) 

 Probably less known to Simulate users is the MODS, 
since this is part of Creo Parametric BMX functionality 
(Behavioral Modeling EXtension) 

 This study allows to examine a complete design space 
with many design variables systematically  

 To obtain the link from BMX to Creo Simulate, an 
analysis feature has to be created in the model tree that 
refers to a Simulate FEM analysis 

 This analysis feature defines which result parameters 
(=measures from the simulate analysis) have to be 
computed by Simulate and recorded by the BMX MODS 

 The obtained parameter results for the complete design 
space can then be evaluated by various table and graph 
display functions to better understand the model 
behavior 
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Part A: Used Software Functionality  

2. Software tools for analyzing parametric geometry 
2.5 Multi Objective Design Study (MODS) 

Setting up a MODS: 

1. Create a new study (File > New) and enter a 
study name (never change this name later!) 

2. Create the master table (Setup > Variables/ 
Goals) and define all design variables with their 
domains as well as the design goals (=Simulate 
measure results) you are interested in 

3. Select the Sampling Method (usually Automatic) 

4. Compute the table (Setup > Compute/Expand) 
by entering the number of  
experiments to generate 
(often more than 1000 
may be required!) 

5. Wait (e.g. 4000 notch  
samples need 8 hours  
to complete) 
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Part A: Used Software Functionality  

2. Software tools for analyzing parametric geometry 
2.5 Multi Objective Design Study (MODS) 

Evaluating a MODS analysis result: 

 Study the table result data with all the single 
experiment data (Table > Show Data) 

 Derive new subtable(s) using constraints  
 define min/max values of the goal(s) 

 Derive new subtable(s) using Pareto method 
 minimize, maximize or exclude goal(s) 

 Derive 2D-Graphs (Tools > Graph Study) 
(unfortunately, no 3D graphs are supported) 

 

Graph example that shows 

sampling points distribution 

for the design variable domain 

(automatic sampling method) 

Graph example that 

allows to judge about 

possible min. stress limit 

curves that can be 

obtained with a certain 

notch dimension in 

general 
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Part A: Used Software Functionality  

3. Software tools for analysis speed and accuracy control 
3.1 p-FEM Mesh: Auto-GEM controls  

 

Goal: 

 Stress results have to be very accurate for 
each notch size to draw smooth sensitivity 
graphs for the complete domain 

First Approach: 

 Use surface areas and edge distribution 
AutoGEM Controls to obtain undistorted 
quad elements 

 It turned out that if the geometry changes 

heavily during the sensitivity analysis, 

elements will distort and a new, often 

unwanted mesh appears 

Chosen Approach: 

 Mesh the most interesting part of the 

geometry just with smaller elements, no 

attention to triangles or quad elements 

 In addition, use advanced SPA controls 

like described next slide 

Big radius size 

changes may 

lead to unwanted 

mesh 

Just smaller 

elements and 

reduced allowed 

element edge 

angle domain and 

aspect ratios (1:3) 

are better to reach 

the goal! 

Edge distribution 

AutoGEM control 

cannot be 

parameterized! 
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Part A: Used Software Functionality  

3. Software tools for analysis speed and accuracy control 
3.2 Convergence settings for sensitivity analysis 

Goals: 

 Stress results have to be very accurate  

 Analysis speed has to be fast even though, 
since a huge amount of notch sensitivity 
studies have to be performed in limited time 

Approaches to reach the goals: 

 Use 2D models where ever possible (plane 
stress, plane strain, axial symmetric) 

 Do not use the accurate, but relatively slow 
multi-pass adaptive (MPA), instead use single 
pass adaptive convergence method (SPA) 

 Use advanced SPA controls to decrease the 
local RMS stress error from default 8 % to 
values <<1 % near the notch surface 

Remark: 
The RMS stress error is the max. difference between direct (raw) 
element stress and smoothened (superconverged) stress 
[Zienkiewics, Zhu 1987] 



Part B: Application  
Notch Stress Decrease due to the Variation of Geometry 
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Part B: Application – Notch Stress Decrease due to the Variation of Geometry 

1. Model of the Cross Section Change used for Notch Examination 
1.1 Geometry Description 

d = 10 mm 

H = 200 mm 

D = 200 mm 

l = 100 
mm 

y 

x 

Varying notch geometry 

Exemplary material: aluminum 
Poisson‘s ratio  = 0,3  
E-modulus E = 70 GPa 

y 

x 

d/2 = 5 mm 

D/2 = 100 mm 

𝜎𝑛𝑜𝑚 = 100 MPa 

Tensile force 

Full model of the examined 
cross section 

Half 
symmetric 
analysis 
model 
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Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

1. Model of the Cross Section Change used for Notch Examination 
1.2 Normalization of Dimensions 

d* = d/d = 1 

 H* = H/d = 20 

D* = D/d = 20 

l* =  l/d = 10 

 In order to create dimensionless 
diagrams, the model dimensions 
have been normalized 

 All measures are related to the web 
thickness d=10 mm 

 It will be shown later that D* and H* 
are large enough to have worst-case 
notch stresses. Smaller values, 
especially for D*, usually lead to a 
notch stress decrease 

 l* was arbitrarily chosen to be 10: It 
just has to be long enough so that 
the load introduction point is far 
enough away from the notch; 
therefore it is subsequently not 
further taken into account 

 For non-circular notches, the 
normalized notch height is named 
h* = h/d and the width b* = b/d 
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Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

2. Range of Validity 
2.1 Load Cases and Geometry Models 

FN 

MB MB 

FN 

MB 

T 

Plane stress model Rotational symmetric model Plane strain model 

Analyzed was just the tension load for 2D plane stress, since it turned out 
this is the worst-case condition for the examined cross-section: 

 Tension creates higher notch stress than bending:  
Bending is less critical 

 Notch stress for the 2D plane stress condition is always higher than in 
the state of  2D plane strain or rotational symmetric case 

 Tension creates higher notch stress than torsion in the rotational 
symmetry-model: Torsion is less critical 

 

FN 
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Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

2. Range of Validity 
2.2 Width Sensitivity Width D* = 20 chosen sufficiently large  

 Almost no further influence on notch stress 

H* = 20 

d* = 1 

H* = 20 

D* = 20 

l* = 10 

FN 
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Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

2. Range of Validity 
2.3 Height Sensitivity Height H* = 20 chosen sufficiently large  

 Almost no further influence on notch stress 

D* = 20 

d* = 1 

H* = 20 

D* = 20 

l* = 10d* 

FN 
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Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.1 Overview 

Six different notch shapes have been examined: 

 

1. One-radius-fillet as “state-of-the-art” 

2. Two-radii-fillet 

3. Baud-fillet (R.V. Baud) 

4. Method of tensile triangles (C. Mattheck) 

5. Standard elliptical fillet 

6. Conical round as generalized elliptical fillet 

1. 

2. 

3. 
4. 

5. 
6. 
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K
t
=1,53 

Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.2 One-Radius Fillet 

 For one-radius-fillets still notch stresses remain  

 E.g. radius 5 mm, normalized to d = 10 mm  R* = 0.5: 

 Exmined radius domain:  0.1 ≤ R* ≤ 5 

 Minimal Kt = 1.05 for R* = 5 

FN 
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Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.2 One-Radius Fillet 

FN 
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Radii R, r and angle α are 

varied (height h and width b 

of the notch geometry only 

as reference dimension!) 

R = 

r =  

= α 

b = 

= h 

Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.3 Two-Radii Fillet 

Web notch stress location 

Radii transition notch 

stress location 

 This notch type uses a large 
radius R at the web joined to a 
small radius r at the base with 
tangent transitions, 
respectively 

 R has the dominant influence 
on the web notch stress  
 choose R as large as 
possible 

 For size reasons, R only 
prevails for a small angle,  
e.g. 3° ≤ α ≤ 10°  
(horizontal line as starting 
point) 

 r and α are adjusted in order 
that radii transition notch 
stress does not increase over 
the web notch stress and the 
used design space is as small 
as possible 
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Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.3 Two-Radii Fillet 

 Alternatively, sensitivity 
studies with a different sketch 
set-up have been performed: 
Height h, width b and angle α 
of the notch geometry are 
varied; radii R & r only as 
reference dimensions 

 This method of approach is 
advantageous if the focus is 
on the absolute notch size, 
not on the radii to be 
manufactured 

 Subsequently, we will first 
show some results for this 
set-up 

 

R = 

r =  

= α 

= b 

= h 
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Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.3 Two-Radii Fillet 

 For a two-radii fillet, in relation to the needed 
design space a much better stress reduction can 
be obtained compared to the one-radius fillet 

 A very good example with Kt=1.0042 is depicted 
here: 
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Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.3 Two-Radii Fillet 

E.g. lowest Kt:  
α= 3; b*= 1.62; 
corresponds to: 
R*=67.848; r*=1.529 
Kt=1.0042 
(see previous slide) 

 The following diagram exemplifies the stress concentration factor Kt for 
a notch height of h*=5 (variable are b* and α) 

FN 
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Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.3 Two-Radii Fillet 

 The following diagram exemplifies the stress concentration factor Kt for 
a notch radius R*=50 (variable: r* and α)  

FN 
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X = 2 ∙ C ∙ sin2 θ
2

 

Y = C ∙ ln tan θ
2

+ π
4

− sin θ  

With:   θ = t ∙ 90 

Z = 0 

C =
d

π
 acc. to Baud 

Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.4 Baud Fillet 

 [Baud, R.V, 1934] recommended to use the shape of a free jet of water 
with the equation given below, proposing C=d/π (note log = ln)  

 This is a curve described in parametric representation with the control 
variable θ as angle of the curve to the X-axis 

 This can be easily coded in Creo Parametric, which expects a parametric 
representation in the curve equation editor 

 Here, t is used as control variable 0 ≤ t ≤ 0.9999 to generate the curve 

 1 as upper limit ( θ =90°)  

cannot be used since then Y 

approaches infinity  
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Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.4 Baud Fillet 

 To obtain a smooth transition to 
the web after t approaches 
0.9999, a tangent constant radius 
of R=1000 mm was added 

 C reflects the width b of the 

notch. It was therefore regarded 

as design variable and was varied 
between 1 ≤ C ≤ 6 

 After normalization, we obtain 

b*=C*=C/d=0.1…0.6 

 For the Baud recommendation we 

have b*=1/π=0.3183 

 The notch dimensions shown right 

reflect the ideal dimensions found 

in this project (b*=0.492): 

Smallest notch size with K
T
=1 

(exact value 1.00046) 

C = 4.92 mm = b 

Baud curve length 

= 43.0931 mm 

(for t=0.9999) 

h
 
=
 
4
1
.
5

8
3

4
 
m

m
 

0
.
1
5

7
 
m

m
 

R= 
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Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.4 Baud Fillet 

 Notch analysis results 
Von Mises Stress 

b = C = 4.92 mm 

Best solution found 

Von Mises Stress 

b = C = d/π = 3.183 mm 

Baud recommendation 

h
 

 
4
2
 
m

m
 

h
 

 
2
7
 
m

m
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Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.4 Baud Fillet 

 It can be observed that no other notch shape keeps the outer fiber stress 
so close to the nominal stress along the complete notch length like the 
optimized baud curve: 

 = 89.991° 

  = t
max

 * 90° 

       = 0.9999 * 90° 
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Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.4 Baud Fillet 

 Stress concentration factor Kt as function of the normalized Baud curve 
width b*(=C*) for dimensioning  

FN 
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Sketch varied from [Mattheck, C., 2006] 

Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.5 Method of Tensile Triangles 

Adverse: 

 Construction in CAD program is 
problematical 

 Spline is individual and unhandy 

 Several one-radius fillets result in an 
irregular contour 

 45° corner at the bottom: Singularity! 

 According to Mattheck: “This location is 
not critical.” 

Mattheck recommends 

 Three/ Four isosceles triangles 

 First triangle: 45° 

 For the following triangles the angle is bisected (22.5°; 11.25°; etc.) and the starting 
point is the middle point of the hypotenuse from before 

 To avoid high singular stress at triangle transition points: 

 Manually put a spline over it  tangential transition in tensile direction 

 Or use one-radius fillets as large as possible  tangential transition in tensile direction 

d/2 = 5 mm 



43 43 

Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.5 Method of Tensile Triangles 

Spline 

FN 

With applied one-radius 
fillet (1mm) : Kt ≈ 1.1  

With 45° corner at bottom:  
Singular peak stress! 

FN 
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Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.5 Method of Tensile Triangles 

With applied one-radius 
fillet (1mm) : Kt ≈ 1.1  

With 45° corner at bottom:  
Singular peak stress! 

Spline 
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 For the standard elliptical fillet, 
the two semi axes are always 
parallel with the web/base, 
respectively 

 So here, the notch height h and 
notch width b always reflect the 
semi-major and semi-minor axis 
of the ellipse: 

h = 

b = 

Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.6 Standard Elliptical Fillet 



46 46 

Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.6 Standard Elliptical Fillet 

 Also with the elliptical fillet type low K
t
 

can be obtained (here e.g. K
t
 = 1.006), 

but the utilization of material is by far 
not as good as with the Baud fillet: 
 



47 47 

Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.6 Standard Elliptical Fillet 

FN 

 The following diagram exemplifies the stress concentration factor Kt for 
a couple of normalized notch heights h* for dimensioning 

Lowest K
t
 of this 

diagram:  

K
t
 = 1.006  

h*= 6, b*=0.76 

(see previous slide) 

Best designs 

are here! 

Elliptical fillets equal 

one-radius fillet ! 
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Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.6 Standard Elliptical Fillet 

FN 

 Why do the curves have a sharp bend? 

h = 15 

b = 4 h = 15 

b = 10 

h = 15 

b = 4.9 
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P 

Q R 

C 

M 
a 

c 

rho = a/(a + c) 

 The conical round is a standard 
feature in Creo Parametric 

 It is defined as follows: 
 Line segments PR and QR are tangential 

to the ellipse at points P and Q 

 The line segment RM = a+c touches 
chord PQ at its midpoint M 

 Point C is the crossing point of the 
parallel line tangential to the ellipse 
with RM 

 Rho=a/(a+c) determines for the conical 
bow segment PQ the shape of the conic 
section 

 In our special case depicted right, if RP 
and RQ are perpendicular to each other 
AND exactly reflect the major-semi axis 
h and the minor-semi axis b of the 

ellipse, we have rho = 2 − 1 = 
0.41421… 

 For other values of rho see next slide 

 

h 

b 

Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.7 Conical Rounds as Generalized Elliptical Fillets 
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 For our special notch case with PR = h and 
QR= b we conclude below: 
 rho > 0.41421: “slim” fillet 

 rho < 0.41421: “fat” fillet 

 The parameter rho therefore seems to be an ideal 
additional control to further optimize our standard 

elliptical notch (having rho = 2 − 1 fixed)  

 For better understanding, a more general case example 
is shown right 

Remark:  
In Creo Parametric, rho values between 0.05 and 0.95 are supported 

Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.7 Conical Rounds as Generalized Elliptical Fillets 
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 Alternatively, instead of changing rho of the conical round we could 
tilt the semi axes of the ellipse and vary their dimensions 

 However varying rho is easier and more stable (feature dimension) 

Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.7 Conical Rounds as Generalized Elliptical Fillets 

rho = 0,2 rho = 0,5 
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Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.7 Conical Rounds as Generalized Elliptical Fillets 

 The conical round allows very low K
t
 (here e.g. K

t
 = 1.0006) 

for bigger h* and utilizes the material much better than the 
standard elliptical fillet 

h = 

b = 

rho = 
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Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.7 Conical Rounds as Generalized Elliptical Fillets 

Lowest K
t
 of this diagram:  

K
t
 = 1.042 

h*= 1.5, b*=0.625, rho=0.5 

FN 

 The following diagram exemplifies the stress concentration factor Kt for 
a very small normalized notch height of h*=1.5 for dimensioning, for 
comparison with the one-radius fillet 

One radius fillet with 

R*=1.5 (K
t
=1.173) 

Too slim fillets (big rho) 

have higher stresses than 

the one-radius fillet! 
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Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

3. Examined Notches 
3.8 Notch layout library 

 Further considerations show that it is possible to draw condensed 
diagrams summarizing the ideal notch dimensions for each notch type 
to reach a minimum possible Kt (approaching 1) 

 The resulting notch layout library allows to quickly design the best notch 
for the actual Kt value needed without additional, time-consuming and 
expensive FEM-analysis, just by reading out the necessary dimensions 
b*, h*, rho, R*, r* or α from the suitable diagram 
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 The standard circular fillet is very inefficient: Very huge R* are necessary 
to obtain Kt approaching one 

 The Baud curve is clearly the best shape from the efficiency point of view, 

closely followed by conical rounds with rho> 2 − 1 and then standard 
elliptical fillets 

 Surprisingly, with the exception of the Baud curve probably, there seems 
to be no „ideal“ solution for the notch shape (e.g. a certain “ideal” semi 
axes relation for the ellipse or a preferred rho for the conical round): The 
best solution depends on the priority (small h* and/or b* and/or Kt) 

 For the Baud curve itself, the theoretical difficulty is that the curve has to 
be “cut” at its end (e.g. after θ=89,991° like in this presentation) and 
rounded to prevent a singular location (=edge<180°). This also effects its 
length along the web and slightly the local stress there 

 In general, if  Kt  1, then all the notches become very size sensitive: A 
further small decrease in Kt often means a significant increase in fillet 
size; furthermore, the FEM results appear to be more sensitive to small 
numerical disturbances 

Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

4. Result Comparison 
Notch Shapes and their Efficiency 
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 Size comparison of some very good 
solutions found  
(for H*=B*=20) 

Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

4. Result Comparison 
Notch Shapes and their Efficiency 

1 2 3 4 5 6 

fillet envelopes h* x b* 

Notch type No. h* b* R* α [°] rho K
t 

One radius fillet 1 - - 0.5 - - 1.5257 

One radius fillet 2 - - 5 - - 1.0544 

Two radii fillet 3 5 1.62 - 3 - 1.0042 

Baud fillet 4 - 0.492 - - - 1.00046 

Standard elliptical fillet 5 6 0.76 - - - 1.00608 

Conical round 6 6 0.825 - - 0.7 1.00064 
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 Size comparison of some different 

notches, all with Kt 1.05  
(for H*=B*=20) 

 

Part B: Application - Notch Stress Decrease due to the Variation of Geometry 

4. Result Comparison 
Notch Shapes and their Efficiency 

2 1 3 4 5 6 

fillet envelopes h* x b* 

Notch type No. h* b* R* r* α [°] rho K
t 

One radius fillet 1 - - 5 - - - 1.0544 

Two radii fillet 2 - - 30 0.56 8 - 1.0498 

Two radii fillet 3 3 1.16 - - 6 - 1.0495 

Baud fillet 4 - 0.45 - - - - 1.0531 

Standard elliptical fillet 5 2 0.725 - - - - 1.0491 

Conical round 6 1.5 0.6 - - - 0.5 1.0484 



Thanks for your attention! 

For any questions or services, 
please contact the authors under 
roland.jakel@altran.com  
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